
Experiment RP-1: The Effects of Exercise on Breathing 

Background

The amount of air that moves in or out of the lungs during any one breathing cycle is called the tidal 
volume. After normal inspiration, it is possible to breathe in additional air—this is called the inspiratory
reserve volume. Similarly, after a normal expiration, it is possible to exhale additional air from the 
lungs—this is the expiratory reserve volume. Even if the expiratory reserve volume is fully expelled 
from the lungs, there is still a volume of air in the lungs, called the residual volume, that cannot be 
exhaled. The residual volume has low oxygen and high carbon dioxide concentrations. Upon 
inhalation, fresh air mixes with stale air from the residual volume to create air in the alveoli that still 
has oxygen and carbon dioxide concentrations that facilitate the diffusion of O2 into and CO2 out of the

capillaries.

The respiration center in the medulla insures that gaseous exchange at the lung matches the 
requirements of the body. During times of increased demand, the tidal volume can be increased, using 
some of the reserve lung volumes to bring more fresh air into the body. In addition, the rate of 
breathing and the rate of air movement in and out of the lungs can be changed. In this lab you will 
measure these parameters in a subject at rest and immediately after exercise, when the body’s demands 
for oxygen have been elevated.

Equipment Required

PC or Mac Computer

IX-ELVIS

USB cable

Power supply

SPN-304 Spirometer and airflow tubing

SP1 Flowhead 

IX-ELVIS Setup

1. Place the IX-ELVIS unit on the bench, close to the computer. 

2. Connect the IX-ELVIS to the computer with the supplied USB cable. 

3. Insert the power plug into the rear of the IX-ELVIS and plug the transformer into the electrical 
outlet. Turn on the power switches on the rear and on the upper right side of the top of the unit 
and confirm that the LEDs are illuminated.

Start the Software

1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is 
not available, click on the Windows Start menu, move the cursor to All Programs and then to 
the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window 
will appear as the program opens.
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2. On the Main window, pull down the Settings menu and select Load Group.

3. Locate the folder that contains the settings group, ELVISNI.iwxgrp. Select this group and click 
Open.

4. Pull down the Settings menu again. Select the Exercise-Breathing-LS2 settings file.

5. After a short time, LabScribe will appear on the computer screen as configured by the Exercise-
Breathing-LS2 settings.

6. The settings used to configure the LabScribe software and the IX-ELVIS for this experiment are
programmed on the Preferences Dialog window which can be viewed by selecting Preferences 
from the Edit menu on the LabScribe Main window.

Spirometer Setup

1. Locate the SPN-304 spirometer, the plastic SP1 flowhead, and the airflow tubing (Figure RP-1-
L1).

2. Firmly push the two air flow tubes onto the two outlets on the plastic flowhead, ribbed tubing to
red outlet. 

3. Firmly push the other ends of the two air flow tubes onto the two outlets on the SPN-304 
spirometer unit, ribbed tubing to red outlet.

4. The Heart Sounds-Spirometer switch on the SPN-304 should be set to the Spirometer position, 
to the left, when the labeled surface of the SPN-304 is facing you. 

Figure RP-1-L1: The SPN-304 spirometer, plastic SP1  flowhead, and the airflow tubing.
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4. Plug the mini-DIN connector to the SPN-304 spirometer into the Channel 4 input of the IX-
ELVIS (Figure RP-1-L2).

Figure RP-1-L2: SPN-304 spirometer and flowhead connected to the IX-ELVIS.

Before Starting

1. Please read the procedures for each exercise completely before beginning the experiment. You 
should have a good understanding of how to perform these exercises before making recordings.

2. The spirometer will monitor breathing from a subject. It is important that the subject is healthy 
and has no history of respiratory or cardiovascular problems.

3. On the flowhead, the outlets connected to the airflow tubing should always be pointed up to 
avoid problems with condensation developing within the tubing.

4. Use a clip to prevent air from entering or leaving the nose as the subject is breathing. air that 
passes through the nose is not included in the volume measurements and causes errors in these 
values.

5. The settings file, Exercise-Breathing, programs LabScribe to record the breathing of the subject 
on the Air Flow channel. The computed function used on the Volume channel converts the data 
recorded on the Air Flow channel to lung volume measurements. 
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6. To be sure that the spirometer calibration parameters are properly configured to accurately 
measure Lung Volume:

• Click on the words STPD Vol Human (Air Flow), that are next to the title of the Lung 
Volume channel, to open the computed function pull-down menu. 

• Select Setup from this pull-down menu to open the Spirometer Calibration Dialog window. 

• The SPN-304 spirometer and the SP1 flowhead should be chosen. 

• Make sure the reset time is set to 'No Reset' and the first ten seconds of the recording are 
used to zero the baseline of the Volume channel. 

• The calibrated volume difference between cursors should be set to one liter. Click OK.

8. Allow the SPN-304 to warm up for 10 minutes before recording for the first time. 

Note: Do not hold the spirometer amplifier in your hand; the heat of your hand will alter the 
volumes recorded.

9. When spirometry data is recorded in the conventional manner, inhalation is always displayed as 
an upward deflection. To determine if the subject is breathing through the correct end of the 
flowhead.

• Click on the Save to Disk button in the lower left corner of the Main window to switch the 
LabScribe software into Preview mode. When LabScribe is in Preview mode, there is a red 
X across the Save to Disk button. In Preview mode, the IX-ELVIS works without recording 
data on the hard drive or any other storage media which allows a subject to become 
comfortable with breathing through a spirometer.

• Click on the Preview button. Have the subject inhale through the flowhead. Click on the 
AutoScale button at the upper margin of the Air Flow and Volume channels. If the tube is 
oriented properly, the traces on the Air Flow and Volume channels will go up during 
inhalation. If the traces on these channels go down during inhalation, reverse the positions 
of the airflow tubes at the outlets of the flowhead.

Note: If the user clicks the Preview button and an error window appears the Main window 
indicating the IX-ELVIS cannot be found, make sure the IX-ELVIS is turned on and connected 
to the USB port of the computer. Then, click on the OK button in the error window. Pull down 
the LabScribe Tools menu, select the Find Hardware function, and follow the directions on the 
Find Hardware dialogue window.

10. Click on the Stop button. 

11. Before proceeding to the actual exercises, make sure the LabScribe software in set to Record 
mode. Click on the Save to Disk button, in the lower left corner of the Main window, to change 
LabScribe from Preview mode to Record mode. When LabScribe is in Record mode, there is a 
green arrow on the Save to Disk button.
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Exercise 1: Breathing While Resting

Aim: To measure breathing parameters in a healthy, resting subject.

Procedure

1. Instruct the subject to:

• Sit quietly and become accustomed to breathing through the spirometer flowhead.

• Breathe normally before any recordings are made. 

• Hold the flowhead so that its outlets are pointed up.

• Remove the tube from his or her mouth and hold it at the mouth level in a position that 
prevents a breath from moving through the tube.

Note: The LabScribe software will zero the Volume channel during the first ten seconds of 
recording. No air should be moving through the flowhead during this time. 

2. Type “<Subject’s Name> Resting” in the Mark box that is to the right of the Mark button. 

3. Click on the Record button. After waiting ten seconds for the Volume channel to zero, have the 
subject place the flowhead in his or her mouth and begin breathing. Press the Enter key on the 
keyboard to mark the recording.

4. Click the AutoScale buttons of the Air Flow and Volume channels. Notice the slowly moving 
wave on the Volume channel. Record ten breaths, which normally takes about 90 seconds to 
record. 

5. Type “Forced” in the Mark box. Press the Enter key on the keyboard as the subject inhales as 
deeply as possible. After reaching his or her maximum inhalation volume, the subject should 
exhale as quickly and as completely as possible.

6. After the forced exhalation is complete, the subject should continue to breathe normally through
the spirometer for five breath cycles.

7. Click Stop to halt recording. Your data may look like Figure RP-1-L1.

8. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 
in which to save the file. Designate the file type as *.iwxdata. Click on the Save button to save 
the data file.
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Figure RP-1-L1: Air flow and lung volumes of the normal and forced breathing of a subject at rest.

Data Analysis-Normal Breathing at Rest

1. Scroll through the recording and find the section of data recorded when the subject was 
breathing while resting.

2. Use the Display Time icons to adjust the Display Time of the Main window to show at least five
complete breathing cycles on the Main window. Four adjacent breathing cycles can also be 
selected by:

• Placing the cursors on either side of a group of five complete breathing cycles; and

• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the four 
selected breathing cycles to the width of the Main window.

Figure RP-1-L2: The LabScribe toolbar. 

Respiratory Physiology-ExerciseBreathing RP-1-6



3. Click on the Analysis window icon in the toolbar (Figure RP-1-L2) or select Analysis from the 
Windows menu to transfer the data displayed in the Main window to the Analysis window 
(Figure RP-1-L3).

4. Look at the Function Table that is above the uppermost channel displayed in the Analysis 
window. The mathematical functions V2-V1 and T2-T1 should appear in this table. Values for 
V2-V1 and T2-T1 on each channel are seen in the table across the top margin of each channel.

5. Minimize the height of the Air Flow channel by clicking on the arrow to the left of the channel’s
title to open the channel menu. Select Minimize from this menu to reduce the height of the 
channel display.

6. Maximize the height of the trace on the Volume channel by clicking on the arrow to the left of 
the channel’s title to open the channel menu. Select Scale from the menu and AutoScale from 
the Scale submenu to increase the height of the data on that channel.

7. Once the cursors are placed in the correct positions for determining the volumes of each breath 
cycle, the values of the parameters in the Function Table can be recorded in the on-line 
notebook of LabScribe by typing their names and values directly into the Journal.

8. The functions in the channel pull-down menus of the Analysis window can also be used to enter
the names and values of the parameters from the recording to the Journal. To use these 
functions:

• Place the cursors at the locations used to measure the volumes of the breath cycle.

• Transfer the names of the mathematical functions used to determine the volumes to the 
Journal using the Add Title to Journal function in the Volume Channel pull-down menu.

• Transfer the values for the volumes to the Journal using the Add Ch. Data to Journal 
function in the Volume Channel pull-down menu.

9. On the Volume channel, use the mouse to click on and drag the cursors to specific points on the 
recording to measure the following volumes: 

• Tidal Volume (TV), which is the volume of air inhaled or exhaled during a normal breathing
cycle. To measure the tidal volume of the subject during breathing at rest, place one cursor 
in the trough prior to inhalation, and the second cursor on the peak of the cycle. The value 
for the V2-V1 function on the Volume channel is the tidal volume.(Figure RP-1-L3).

• Breath Period, which is the duration of each breathing cycle. To measure the breath period 
of the subject during breathing at rest, place one cursor on a peak of a breath cycle, and the 
second cursor on the peak of an adjacent cycle. The value for T2-T1 on the Volume channel 
is the period of that breath cycle (Figure RP-1-L4).

10. Record the values in the Journal using the one of the techniques described in Steps 7 or 8.

11. Repeat the measurements of tidal volume and breath period on two additional normal breath 
cycles
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Figure RP-1-L3: Breathing pattern of a subject at rest, displayed on the Volume channel in the Analysis
window. The cursors are positioned on the trough and the peak of the breath cycle to measure the tidal 
volume (TV) with V2-V1 function.

Figure RP-1-L4: Normal breathing pattern of a subject at rest, displayed on the Volume channel in the 
Analysis window. The cursors are positioned on the peaks of successive breath cycles to measure the 
breath period with the T2-T1 function.
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12. Average the three values obtained for each parameter and enter the means in a table in the 
Journal. You can open and close the Journal by clicking on its icon on the LabScribe toolbar 
(Figure RP-1-L2).

13. Record the means for the tidal volume and breath period in Table RP-1-L2.

14. Calculate the normal breathing rate of the subject at rest using the following equation:

Breath Rate (breaths/minute) = (60 seconds/minute) / mean breath period (sec/breath)

15. Multiply the mean tidal volume by the breathing rate to calculate the volume of air passing in 
and out of the resting subject’s lungs each minute.

16. Record the values for these calculations in Table RP-1-L2.

Data Analysis-Forced Expiration at Rest

1. Use the slider or the arrows on the scroll bar, at the bottom of the Analysis window, to position 
data recorded when the subject exhaled with maximum force in the window.

2. Use the Display Time icons to adjust the Display Time of the Analysis window to show the 
forced expiration curve and the two normal breaths, that occur before the force expiration curve,
on the same window. These breathing cycles can also be selected by:

• Placing the cursors on either side of the group of appropriate breathing cycles; and

• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the selected 
breathing cycles to the width of the Main window. The segment of the recording displayed 
in the window should be like the recording in Figure RP-1-L5.

3. Use the same techniques used earlier to record volumes in the Journal by:

• Typing the names and values of the parameters directly into the Journal, or;

• Transferring the names and values of the parameters into the Journal by using the Add Title 
to Journal and the Add Ch. Data to Journal functions in the Volume Channel menu.

4. Place the cursors on the forced expiration data displayed on the Volume channel to measure the 
following volumes using the V2-V1 and T2-T1 functions. Check the labels on Figure RP-1-L5 
to identify the volumes that you will measure:

• Tidal Volume (TV), by placing one cursor in the trough before the inhalation segment of the
resting breath and the second cursor on the peak of that resting breath cycle. The value for 
the V2-V1 function on the Volume channel is the tidal volume.

• Inspiratory Reserve Volume (IRV), by placing one cursor on the peak of the normal breath 
prior to the maximum inhalation and the second cursor on the peak of the forced breath 
cycle. The value for the V2-V1 function on the Volume channel is the inspiratory reserve 
volume.

• Forced Vital Capacity (FVC), by placing one cursor on the peak of the forced breath cycle 
and the second cursor on the flat line after the subject has expelled all the air from his or her
lungs. The value for the V2-V1 function on the Volume channel is the forced vital capacity.

• Expiratory Reserve Volume (ERV), by placing one cursor in the trough before maximal 
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inhalation and the second cursor on the flat line after subject has expelled all the air from his
or her lungs. The value for the V2-V1 function on the Volume channel is the expiratory 
reserve volume.

• Forced Expiratory Volume at 1 Second (FEV1), by placing one cursor on the peak of the 

maximum breath cycle and the second cursor on the data point that is one second after the 
peak. Use the T2-T1 function to determine the data point that is one second after the peak. 
The value for the V2-V1 function on the Volume channel is the forced expiratory volume at 
one second.

• Forced Expiratory Volume at 3 Seconds (FEV3), by placing one cursor on the peak of the 

maximum breath cycle and the second cursor on the data point that is three seconds after the
peak. Use the T2-T1 function to determine the data point that is three seconds after the peak.
The value for the V2-V1 function on the Volume channel is the forced expiratory volume at 
three seconds.

Figure RP-1-L5: Recording of normal and forced lung volumes taken from a subject at rest and 
displayed on the Volume channel in the Analysis window. The normal breathing cycles are to the left of 
the forced inspiration and expiration. Lines and labels were added to figure to indicate the volumes. 

5. Record these volumes in Table RP-1-L3
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Table RP-1-L1: Lung Volumes for an Average- Sized Human Male (70kg).

Volumes Volume (mls)

Tidal Volume (TV) 500

Inspiratory Reserve Volume (IRV) 3100

Expiratory Reserve Volume (ERV) 1200

Forced Vital Capacity (FVC) 4800

Residual Volume (RV) 1200

Data Analysis-Forced Expiration Ratios

Respiratory diseases can be classified into one of the many different categories. The two most common 
categories are obstructive airway diseases and restrictive lung diseases.

Obstructive airway diseases are characterized by the limitation of airflow in the airway. These diseases 
are not fully reversible. In obstructive airway diseases, like asthma, bronchitis, or emphysema, both 
Forced Vital Capacity (FVC) and Forced Expiratory Volume (FEV) are reduced, and the ratio of 
FEV1/FVC is usually less than 0.70.

Restrictive lung diseases are chronic disorders that cause a decrease in the ability to inhale and expand 
the lung which prevents the proper amount of oxygen from entering the circulatory system and meeting
the body’s needs. In restrictive lung diseases, like cystic fibrosis, tuberculosis, or poliomyelitis, FVC is 
reduced. However, the FEV1/FVC ratio can be normal or greater than normal (>0.85) because the lungs

have the ability to easily return to their deflated size, a characteristic known as low compliance or high 
recoil

1. Calculate the subject’s FEV1/FVC ratio by dividing the subject’s FEV1 value by his or her FVC

value.

2. Calculate the subject’s FEV3/FVC ratio by dividing the subject’s FEV3 value by his or her FVC

value.

3. Compare the FEV1/FVC and FEV3/FVC ratios of the subject to the normal values: 0.70 to 0.80 

for FEV1/FVC; and, 0.95 for FEV3/FVC for young healthy adults. Both of these ratios decrease

with age.

4. Record the FEV1/FVC and FEV3/FVC ratios in Table RP-1-L3.
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5. Record the volumes from your subject in the table being compiled for all the subjects in the 
class

Exercise 2: Breathing Immediately After Exercise

Aim: To measure the breathing parameters of the same healthy subject after exercise.

Procedure

1. In this exercise, use the same healthy subject whose breathing parameters at rest were measured
in Exercise 1. 

2. Type “After Exercise” in the Mark box to the right of the Mark button. 

3. The subject should exercise to sufficiently elevate breathing rate, but with minimal class 
disruption. Running up and down flights of stairs is a good method. The subject should sit down
after the exercise period. 

4. Click on the Record button. After waiting ten seconds for the Volume channel to zero, have the 
subject place the flowhead in his or her mouth and begin breathing. Press the Enter key on the 
keyboard to mark the recording.

5. Click the AutoScale buttons of the Air Flow and Volume channels. Record at least five breaths 
as the subject is recovering from exercise. 

6. Type “Forced” in the Mark box. Press the Enter key on the keyboard as the subject inhales as 
deeply as possible. After reaching his or her maximum inhalation volume, the subject should 
exhale as quickly and as completely as possible.

7. The subject should return to breathing as normally as possible through the spirometer.

8. Click Stop to halt recording.

9. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 
in which to save the file. Designate the file type as *.iwxdata. Click on the Save button to save 
the data file. 

Data Analysis

1. Perform the same types of measurements on the data recorded in Exercise 3 as were performed 
on the data recorded in Exercises 1 and 2. Record the measurements in the Journal. Report the 
appropriate measurements in Table RP-1-L2 and RP-1-L3.

2. Determine the values for the calculated parameters taken from the recordings of normal and 
forced breathing after exercise. Report these values on Table RP-1-L2 and Table RP-1-L3.
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Exercise 3: Breathing Parameters from Other Students

Aim: To measure breathing parameters in other students in your lab group. Obtain data from 
subjects in other lab groups.

Procedure

1. Attach a clean flowhead and clean air flow tubing to the spirometer for each new subject in 
your group doing this exercise.

2. Open a new data file for the new subject by selecting New on the File menu of the LabScribe 
program. The Save File dialogue window will appear on the screen if the current data file 
displayed on the LabScribe window if that file has not been saved recently. Click Yes to save 
the current file. The Choose a file dialogue window will appear on the screen. Select the folder 
where you would like the data file to be saved. Enter a name for the file and select the *.iwxdata
as the type of file being saved. Click the Save button in the lower right corner of the dialogue 
window.

3. Repeat Exercise 1 with the new subject. 

Data Analysis

1. Perform the same types of measurements on the data recorded in Exercise 3 as were performed 
on the data recorded in Exercises 1 and 2. 

2. Record the measurements in the Journal. Report the appropriate measurements in a data table 
for all students.

3. Determine the values for the calculated parameters taken from the recordings of normal and 
forced breathing. Report the values for each subject on copies of Table RP-1-L2 , Table RP-1-
L3, and on the table being compiled for all subjects in the class.

Questions

1. Are the lung volumes the same in all students?

2. Combine class data to see whether there is any correlation between tidal volume or vital 
capacity and gender, smoking, or apparent fitness.
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Table RP-1-L2: Mean Breathing Volumes from a Healthy Subject at Rest and after Exercise

Resting After Exercise

Mean Breath Period (sec/breath)

Breathing Rate (breaths/min)

Mean Tidal Volume (mls/breath)

Minute Air Flow Rate (liters/min)

Table RP-1-L3: Forced Expiration Volumes from a Healthy Subject at Rest and after Exercise

Lung Volumes (Liters) Resting After Exercise

Tidal Volume (TV)

Inspiratory Reserve Volume (IRV)

Expiratory Reserve Volume (ERV)

Forced Vital Capacity (FVC)

Forced Exp. Volume at 1 sec (FEV1)

FEV1/FVC Ratio

Forced Exp. Volume at 3 sec (FEV3)

FEV3/FVC Ratio

Questions

Use your Anatomy and Physiology textbook to help determine the correct answers to the following 
questions.

1. Did tidal volume change after exercise? Did inspiratory and expiratory reserves change after 
exercise?  What is your reasoning?

2. Did exercise influence the time taken for each breathing cycle?

3. Did the volume of air passing in and out of the subject’s lungs each minute increase or decrease 
due to exercise? If so, was the change due to an increase in the rate of breathing, the depth of 
breathing (tidal volume), or a combination of both factors?
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4. Did exercise influence the overall vital capacity of the individual?

5. If the tidal volume changed due to exercise, can this be accounted for by changes in the IRV, the
ERV, or a combination of both?

6. Compare your data to what is supposed to happen physiologically. How do expected results 
compare to the observed results? Did you see what is expected? Use your book or a website to 
find your answer.
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